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Chapter 7 

Introduction to the Microsoft Access Database 
 

Objectives 
This chapter introduces the database application called Microsoft Access. You will 

explore the help manual that is provided with Access, examine a previously created 

database and modify this previously created database. This chapter is restricted to a 

database that consists of just one table. 
 

This chapter will cover: 

 Adding a new field to a table 

 Adding and deleting records 

 Creating a Form 

 Creating a Report 

 Creating a Query 
 

Preparation 
Read the whole of the chapter before beginning the exercises. 

 

Exercise 1 – The Help Manual 
 

Launch Microsoft Access from the Start/All Programs/Microsoft Office menu.  
 

A welcome window will appear showing a number of available templates, with the Blank 

database chosen as the default. Click on Help in the menu on the left side of the welcome 

window and choose Microsoft Access Help. The Access Help window shown in Figure 

7.1 appears. In Access Basics you should carefully read the sections named: 

 Learn the structure of an Access database 

 Introduction to tables 

 Introduction to queries 

 Introduction to forms 

 

From the Help menu you can also explore Getting started with Access 2010. In 

particular, click on Never used Access before?.  
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Figure 7.1 – the introductory help material 
 

 
 

Use the Back button to return to the window shown in the figure when you have finished 

reading a section. 

 

You should gather from reading this information that tables - more commonly called 

relations - within a database somehow divide up the data into “topics”. Queries on the 

other hand are used to retrieve data from the database (sometimes by combining data 

from different tables). Forms are used primarily to provide a simple way to enter data into 

the database since they can selectively display certain fields for which the database user 
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must enter data. Reports, as the name implies, are used to create nicely formatted 

summaries of the data including graphs of various types for a report. 

 

Hopefully this has given you an overview of the database application. We are going to 

focus on creating queries, forms and reports using a database with a single table in the 

rest of this lab. 

 

 

 

 

Exercise 2 – the Athlete Database 
 

Copy Exercise 2 (Ch_7(.accdb)) found in Support Files (Chapter 7) on the course 

website to a folder you create called, say, Ch_7 in your own account or computer.  

 

Open this database file - by double clicking on it, for example. The window shown in 

Figure 7.2. Notice that the Tables tab is selected (if it’s not, click on it now) and that one 

table called ATHLETE exists in the database. Click on the little downward pointing 

triangle to the right of Tables tab, and click on the other tabs – Queries, Forms, etc. 

You’ll add some of these things shortly. 

 

Figure 7.2 – The athlete database 
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Return to the Tables tab, and double-click on the ATHLETE tab. You should see a table 

of data appear as shown partially in Figure 7.3. This table consists of 25 records (you can 

see that specified at the bottom of the window) and each record has 9 fields named ID, 

Name, Height, Weight, etc. This table is the raw data if you like. In general you or 

another user of the database would not want to add or delete data directly using this table. 

Although you could do so, it is not particularly convenient. 

 

Figure 7.3 – the athlete table in the Athlete database 
 

 
 

Click on the right pointing arrow at the bottom of the ATHLETE table window and 

observe that you can move down the list of records. It is possible to change the data in a 

field of any record and to add new records to this table. 

 

To add a new record move to the very bottom of the table (you can do this by clicking on 

the button showing a right pointing arrow and an asterisk), click in the Name field and 

type a new last name (your own perhaps). Fill in the other fields as well and you’ll have a 

complete new record. 
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To change data simply position the cursor in the field that you want to change, delete the 

existing value and type the new one. Try this with the new record you just added. You 

can also delete a record. Make sure the record you just added is selected (click on the far 

left so that the whole row is highlighted) and choose Delete in the Records group within 

the Home tab. 

 

Access will ask you to confirm that you want to delete the record, and this illustrates an 

important feature of a database. Generally the changes you make are immediately made 

in the version of the database that is stored on the hard disk. Most other applications store 

changes in main memory without affecting the file that is stored on disk. If you quit most 

other applications without first choosing File/Save or File/Save As you would then be 

asked if you want to save the data, i.e. the changes you had made. You’ll find that you 

can quit Access without being asked to save a file – and this is because the changes you 

make have already been made to the disk file. 

 

Creating a Data Input Form 
 

There are many ways to create a form. After you have followed the steps here you should 

experiment with the various methods that you will see in passing while doing it the way 

described here. 

 

We would like a simply designed layout that will make data entry an easy task.  
 

Click on the Tables tab and then click on the Forms tab.  Now click on the Create tab, 

and then click on Form Design within the Forms group. 

 

The window shown in Figure 7.4 should appear. This is an empty form displayed in the 

Design view. The Design view is the mode that lets you design the appearance of the 

form using the various tools shown in the Control group in the ribbon. We’ll create a two 

page form with tabs that let us switch between the pages. One page will contain the 

athlete’s id, name, height and weight. The other page will contain the various 

performance measurements such as reach, jump/reach etc. 

 

Roll the mouse over the objects displayed in the Controls group in the ribbon, pausing at 

each one until a label appears that names the object. Amongst the objects you should find 

one called Tab Control. (It’s a small icon that looks like two file folders with tabs.) Click 

on this object, move the mouse back into the form window (the mouse icon will be a 

cross with file folder and tabs) positioning it in the upper left corner of the window and 

click. This places two pages named Page1 and Page2 in the form window. 

 

 

  



The Glade Manual  CSE1520.03 

  Computer Use: Fundamentals 

 

 

 

 

 

 

 7-6 

Figure 7.4 – the form design view 
 

 
 

Take a moment to see that you can switch between the design view and the form view. 

Click on View in the Views group at the extreme left end of the ribbon and then select 

Form View. You’ll see the form window change – the background grid will disappear and 

the two blank pages with tabs will be left. Switch between the tabs by clicking on them. 

We have yet to add data to these pages, so return to the design view by clicking on 
View/Design View from the command menus or ribbon again. 

 

To add data to these pages you need to select Add Existing Fields from the Tools group. 

Double-click on ATHLETE to show the list of fields. You want to place the id, name, 

height, and weight fields on page 1. Make sure Page1 is selected and then select these 

four fields by clicking on one of them and then holding the shift key down while you 

click on each of the other three. Release the shift key and then drag the selected fields 

onto page 1. You should end up with something like what is shown in Figure 7.5. 

 

If you want to you can position and resize each of the field text boxes and the field 

names. Click on any one of the fields and square handles will appear around it. Carefully 

move the mouse around the selected field and you’ll see it change into a four headed 

arrow (you’ll be able to drag the whole field to position it) or a double headed arrow 

(you’ll be able to resize the box). 
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Figure 7.5 – adding fields to a page in the form design view 
 

 
 

Select the Page2 tab, then select the remaining fields (Reach, Jump/Reach etc) and drag 

them onto page 2. Position and resize them as you see fit. 

 

Return to Page1 and select Property Sheet from the Tools group. The window shown in 

Figure 7.6 appears, which allows you to change certain properties of the page. In this case 

we simply want to change the name of the page – so change Page1 to Personal as 

shown in the figure. Return to Page2 and change its name to Measurements. 

 

Figure 7.6 – properties of the form page 
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This simple data entry form is finished – so use the View/Form View command to leave 

the design mode. You’ll find that data from the athlete table is now displayed in the form.  

You can still edit the data values and add new records or delete records and all such 

changes will appear in the athletes table that we looked at previously. The only difference 

is that the interface by which we do such data entry tasks is a lot cleaner. 
 

Click on the x button to close the form window and you’ll be asked if you want to save 

the form and to give the form a name. A suitable name would be DataEntry for example. 

 

Creating a Report 
 

A report is quite simple to create – at least if you’re satisfied with the design templates 

that are provided with Access. Sometimes a bit of design tweaking is required, as you’ll 

see in the following. 
 

Select the Reports tab in the Navigation Pane. (The Navigation Pane is the same area 

where the Tables and Forms tabs are located.)  Click on the Create tab and then click on 

Report Wizard within the Reports group. 
 

The window shown in Figure 7.7 will appear – the first in a series of steps that the Report 

Wizard will guide you through. This step allows you to select the fields that you want 

displayed in the report. You can select a field in the Available Fields: list and click on 

the single arrow button to send it to the Selected Fields: list. If there were more tables 

in the database you could also select fields from different tables to include in the report.  

In this case we want all of the fields to be in the report so simply click on the double 

arrow button and you’ll see that all fields are transferred to the Selected Fields: list. 

 

Figure 7.7 – selecting fields for the report 
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Clicking on the Next button will take you to a window that asks if you want any 

grouping. Grouping doesn’t make much sense in the context of this database (we’ll see its 

use later) so simply click on the Next button to carry on. The following step allows you 

to choose whether to sort the data according to some field. We’ll sort it alphabetically by 

name but you’ll see you could easily sort by some other field or combinations of fields. 
 

Click on the pull down list arrow in the top text box and you’ll see a list of the fields in 

the database (Figure 7.8). Simply select the Name field from this list. The button to the 

right of the text box indicates that the data will be sorted from A to Z (Ascending). Click 

on this button and you’ll see it change to indicate Z to A (Descending). Set it back to A to 

Z (Ascending) and move on to the next stage. Notice that it doesn’t make sense with the 

data in this database to perform a multilevel sort. We’ll see a multilevel sort later. 
 

The next panel allows you to choose how to layout the data. Experiment with the options 

available to see what they are, but select the Tabular layout before moving on. Notice 

also that the Landscape page could be chosen here if the data was particularly wide.  

 

Figure 7.8 – choosing a field by which to sort the records for the report 
 

 
 

In the next panel you can select the appearance of the title for the report. Examine each of 

the options and select the one you like before moving on to the final step in which you 

can actually specify the title for the report. A suitable title might be All Athlete Data. 

Finally click the Finish button. 
 

However, you’re not actually finished because when you look at the report you’ll see that 

the column headings are too long to be properly displayed in some cases. You’re going to 

have to fix that or your boss will think you’re hopeless! 
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Adjusting the Report Design 
 

Click on Close Print Preview tab which leaves you in Design View. You should now have 

a window similar to that shown in Figure 7.9. Notice that the main window is divided 

into 5 parts labeled Report Header, Page Header, Detail, Page Footer and Report 
Footer. The Report Footer area is currently empty but the other areas each display 

elements of the report. 

 

Figure 7.9 – the design mode for a report 
 

 
 

Each of these elements can be edited since we’re in design mode. For example, in the 

page header the column heading Jump/Reach is mostly obscured because the space 

allocated for it is too small. One way to fix this is to expand vertically the space given to 

it. To do this carefully move the mouse over the vertical ruler on the left edge of the 

window to position it just above the block indicating the start of the Detail section. The 

mouse shape should be a vertical double headed arrow with a horizontal line through it. 

You can now drag the boundary down in order to expand the area allocated to the page 

header. Once you’ve done this click on the Jump/Reach heading (handles will appear) 

and drag the lower edge of the text area down. Adjust the Ball Toss heading in the same 

way. You should obtain a result similar to Figure 7.10. 
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Figure 7.10 – adjusting the page header in the design of the report 
 

 
 

You also need to adjust the space allocated to the other column headings in the page 

header – but these others will also require that the spaces allocated in the Detail section 

also be adjusted to match whatever you do to the headings. You need to make a little 

more horizontal space for the Weight and Vertical headings, so reduce the horizontal size 

of the ID heading and the ID area in the Detail section. Next move the Height heading to 

the left a bit, and also the Height area in the Detail section. Now you can expand the 

horizontal space for the Weight heading. Continue in the same manner in order to make 

space for the Vertical heading. Select Layout Preview from View in Views group at the 

extreme left end of the ribbon. 
 

You’ll probably find that the report is still not quite right – there’s a thick horizontal line 

that you have to move down a little way so that it properly separates the column heading 

from the data in the report. You should be able to do this yourself. 

 

Adding a Field to the Database 
 

You would like to add a new field to the database in which to record the number of 

training sessions an athlete has attended. The number of sessions will not exceed 5 and of 

course will be 0 initially. To add the field you need to access the athlete table in design 

mode. So first close any Form or Report windows that you might have open (saving 

things or not as appropriate) and then click the Tables tab in the Navigation Pane. The 

athlete table should be selected (it’s the only one in this database). Select Design View in 

View within the Views group.  A window similar to the one shown in Figure 7.11 should 

appear. 

Figure 7.11 – the table design window 
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In design mode we are able to change features of the original table from which the data 

we have so far been using originates. The name and data type of each field is listed in the 

top part of this window. In the bottom part you can see the properties of the field that is 

currently selected –the ID field in the figure. Click on the far left of the row containing 

the Name field and observe the Field Properties area. Notice that the length of a name is 

restricted to, say, 100 characters as indicated by the Field Size property shown in the 

lower region of the window. Click on the data type Text in the Name field row and then 

on the pop-up list arrow that appears in the data type region for this field. You should see 

a pop-up list containing the possible data types that could be specified. Don’t change the 

data type for this field – just examine them. 
 

Scroll to the bottom of the list of fields and in the first empty row type the name 

Sessions for the new field that will contain the number of training sessions the athlete 

has attended. Then click in the Data Type column and select Number from the pop-up 

list. Since we know that the number of sessions must be between 0 and 5 we can specify 

some properties that will help us ensure that mistakes are not made when the actual data 

are entered for this new field. 
 

In the Field Properties area check that the Default Value is 0 (it should be set to 0 by 

default). This means that whenever a new record is added to the table the value for 

Sessions is set to 0 by default. Next you would like to set a validation rule for the input. 

This rule will specify what the range of valid values for Sessions is. If the database user 

tries to enter any value outside the range they will see a warning message that prevents 

them from entering such a value. There are a number of ways in which you could enter 

the validation rule. You could specify each value that is permitted by typing: 
 

1 or 2 or 3 or 4 or 5 
 

or you could use an operator such as 

<= 5 
 

Either way is suitable in this instance, although clearly specifying a condition, as in the 

second approach, is of more general use. You should also set the Decimal Places 

property since you know there will not be any decimal figures in this field. 
 

You have now finished defining the new field and you should return to the Datasheet 
View (using the View menu). You’ll see that the table now contains a new column for the 

field Sessions, but the field does not have any data values as of yet. 
 

To enter the data values you should return to the form that you created previously and 

add the new field Sessions to it. You’ll need to enter design mode and place the 

Sessions field onto the Personal page of the form. You should end up with something 

like Figure 7.12. You’ll find that it is quite easy to enter data into the Sessions field 

now. Make sure you deliberately enter some values that do not meet the validation rule 
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just to see what happens. Make sure that you end up with all athletes having attended 2 

sessions except for Cirny, Ofijoki and Jecksin who attended 4. 

 

Figure 7.12 – the Personal page of the data entry form 
 

 
 

 

Calculating Values from the Data in a Table 
 

Athletes are ranked by an index rating that is calculated from the values for height, 
weight, reach, vertical, agility and ball toss according to the following formula: 

 

Index rating = height/weight*100 + (reach–2.24)/10 + 2*vertical 
+ ball toss/7.5 – agility + 6 

 

A calculated value such as this should be contained in a query. In this example we’ll 

create a query that contains just the name of the athlete and the calculated value of the 

index rating. In general however, queries can be used for extracting data from the 

database, often for the purpose of analysing the data in some way, rather than just for 

calculating values. So don’t be misled into thinking that this example we’re about to do is 

the only purpose of queries. 
 

Click on the Queries tab in the Navigation Pane, then click on the Create tab and then 

click on the Query Design tab in the Queries group. The Show Table window shown in 

Figure 7.13 will appear. This window allows you to select the tables and (other) queries 

from which the data used in the query you are now constructing are to come. There is 
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only the one source of data in this athlete database example – so simply select the 

ATHLETE table and click the Add button.  

 

Figure 7.13 – selecting the sources of data for the query 
 

 
 

You should see the field list for the ATHLETE table appear in the Query1 window. If 

you had other sources of data and were to select them the field lists for those sources 

would also appear in the Query1 window. Close the Show Table window. 
 

Let’s first add the Name field to this query. You can do this by selecting the Name field 

from the small window for the athlete table in the upper portion of the query window 

(Figure 7.14) and dragging it to the first column in the row labeled Field: in the lower half 

of the window.  
 

Figure 7.14 – the design mode window of a Select Query (showing the Name field added) 
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Alternatively you can use the pop-up list activated by the down pointing arrow on the 

right of the first column for the Field: row or you could just double click on the Name 

field. Once you have entered the name field in this manner sort the query by ascending 

name (i.e. A to Z) by clicking in the Sort: row and choosing Ascending from the pop-up 

list. 
 

To add a calculated field to the query you need to construct the formula that will calculate 

the value, entering this formula into the next column of the Field: row. The query will 

then have two fields – the name and the calculated value. 
 

Click in the Field row to the right of the Name field you just added and then click on the 

Builder icon in the Query Setup group. 

 
 

This allows you to build a formula by clicking on the various components that the 

formula requires. The window shown in Figure 7.15 appears. Double click on the file 

name in the Expression Elements column, then double-click on Tables and then double-

click on the ATHLETE entry before what you see is the same as the figure. 

 

Figure 7.15 – the Expression Builder window (showing the ATHLETE table opened) 
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Double-click on the Height field in the Expression Categories column, then type a / for 

division, and then double-click on the Weight field. You have just started to build the 

formula. Continue either typing symbols or selecting and pasting fields until you have 

constructed the formula shown below, which gives the index rating. 
 

[ATHLETE]![Height]/[ATHLETE]![Weight]*100+([ATHLETE]![Reach]-2.24)/10 

+2*[ATHLETE]![Vertical]+[ATHLETE]![Ball Toss]/7.5-[ATHLETE]![Agility]+6 

 

Notice the parentheses ( … ) around (reach-2.24)/10. Without them you would have 

reach-2.24/10 which is not what we want. Also observe that the table name [ATHLETE]! 

precedes each field name in the formula. 
 

When you close the Query1 window you will be asked if you want to save it (yes) and to 

give the query a name – IndexRating would be suitable. Open the query again and you 

should see the two columns shown in Figure 7.16 (except that yours will be sorted by 

Name). Your values in the Expr1 column should be the same as those shown here if you 

have constructed the formula correctly. 

 

Figure 7.16 – the IndexRating query 
 

 
 

You have not finished with this formula yet, however. You realise that you should 

include the Sessions value that you added to the athlete table a moment ago. Each athlete 

is to receive an additional point to their index rating if they attended one or two sessions 

and 2 points if they attended 3 or more sessions. This will require an IIF function to select 

whether to add 1 or 2 to the index rating value. You will have to modify the formula for 

the IndexRating to include this additional term. 
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Begin to edit the formula by selecting Design View from the View menu, clicking in the 

Field row for Expr1 and clicking on the build button. Make sure you type a + symbol at 

the very end of the formula and then find the IIF function in the Functions/Built-In 

Functions/Program Flow group of functions. The arguments are very similar to what you 

encountered in Excel, so you should be able to construct the piece of the formula which 

will add 1 if the sessions value is 2 or less, or which will add 2 if the sessions field value 

is 3 or greater. 

 

Creating a Report from a Query 
 

Now that you have the Query results displaying only the athlete name and the index 

rating, create a report showing just these two values. The report should be nicely laid out 

and should be sorted by increasing value of the index rating. Figure 7.17 shows the first 

few entries as an example of the kind of report you should create. Notice that in addition 

to being sorted the values of the index rating are formatted to display only 2 decimal 

figures. A clue as to how you can do this is that you can select the Expr1 field in design 

mode and set its properties. 

 

Figure 7.17 – a Report derived from the Index Rating Query 

 

 

 


